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 نویبا آردو NodeMcuبرد توسعه  ی: راه انداز کرویبخش اول آموزش نود م

 

 مقدمه

 ESP-داشتیم ، به معرفی و راه اندازی ماژول ESP8266 آموزش کامل راه اندازی ارتباط وای فای با در آموزش قبلی که با عنوان

رداختیم و برای استفاده راحت تر آن هدر فایل استانداردی پ C و زبان برنامه نویسی Codevision در نرم افزار ESP-12E و 01

 قابل مشاهده می باشد. در این آموزش به راه اندازی ارتباط وای فای با استفاده از برد توسعه این لینک نیز نوشتیم که در

NodeMcu  در نرم افزار آردوینو خواهیم پرداخت. برد توسعه NodeMcu کاربرد با دارای یکی از ماژول های معروف و پر

بسیاری از پروژه های الکترونیکی که نیاز به اتصال به شبکه اینترنت دارند مورد استفاده قرار می  می باشد که در WiFi تکنولوژی

گیرد. توسط این ماژول می توان یک سرور اینترنتی راه اندازی کرده و با انواع وسایل الکترونیکی نظیر موبایل، کامپیوتر، لپتاب و 

ین ماژول به علت کوچک بودن می تواند در کاربرد های اینترنت اشیاء نیز به کار حتی ربات تلگرام ارتباط برقرار کرد. همچنین ا

 .را بیان خواهیم کرد NodeMcu گرفته شود. در بخش اول این آموزش به طور کامل نحوه راه اندازی برد توسعه

 

https://electrovolt.ir/%d8%a2%d9%85%d9%88%d8%b2%d8%b4-%d8%b1%d8%a7%d9%87-%d8%a7%d9%86%d8%af%d8%a7%d8%b2%db%8c-%d9%85%d8%a7%da%98%d9%88%d9%84-esp8266/
https://electrovolt.ir/%d8%a2%d9%85%d9%88%d8%b2%d8%b4-%d8%b1%d8%a7%d9%87-%d8%a7%d9%86%d8%af%d8%a7%d8%b2%db%8c-%d9%85%d8%a7%da%98%d9%88%d9%84-esp8266/
https://electrovolt.ir/product/%d8%af%d8%a7%d9%86%d9%84%d9%88%d8%af-%d9%87%d8%af%d8%b1-%d9%81%d8%a7%db%8c%d9%84-%d9%85%d8%a7%da%98%d9%88%d9%84-%d9%88%d8%a7%db%8c-%d9%81%d8%a7%db%8c-esp8266/
https://electrovolt.ir/product/%d8%af%d8%a7%d9%86%d9%84%d9%88%d8%af-%d9%87%d8%af%d8%b1-%d9%81%d8%a7%db%8c%d9%84-%d9%85%d8%a7%da%98%d9%88%d9%84-%d9%88%d8%a7%db%8c-%d9%81%d8%a7%db%8c-esp8266/
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 چیست؟ WiFi تکنولوژی

می باشد به نوعی تکنولوژی ارتباط بدون سیم اطلاق می شود که در شبکه های  Wireless Fidelity که مخفف WiFi عبارت

قرار می گیرد. در قدیم تنها راه اتصال رایانه ها به  مورد استفاده ( Wireless Local Area Network ) محلی بدون سیم

یکدیگر استفاده از کابل شبکه بود که علاوه بر زحمات زیاد، محدودیت های فیزیکی زیادی برای کاربران ایجاد می کرد اما به 

ین دیجیتال، تلویزیون، می توان رایانه ها و دیگر دستگاه های دیجیتالی، مثل تلفن همراه، تبلت، دورب Wi-Fi وسیله فناوری

 باشد می ثبلوتو شبیه بسیار فای وای ارتباط. کرد ایجاد سیم بی شبکه یک و کرد متصل یکدیگر به سیم بدون را …چاپگر، و 

 در استفاده مورد استانداردهای همچنین. باشد می بلوتوث ارتباط از تر قوی فای وای ارتباط ، پوشش مورد گستره نظر از اما

Wifi و bluetooth  و نحوه عملکرد کلی آن دو با هم متفاوت می باشند. بلوتوث و وای فای استانداردهای رمز نگاری متفاوتی

 ) نیز دارند و هر کدام از آن ها با الگوریتم های رمزنگاری متفاوتی ایمن می شود. وای فای در پایین ترین لایه عملکرد

physical layer  ) از استاندارد بدون سیم IEEE 802.11  استفاده می کند. در شکل زیر انواع استانداردهای فیزیکی وای فای

 4.2که در فرکانس  n و  b  ،g نسخه های IEEE 802.11 و گستره پوشش هر یک از آن ها را مشاهده می کنید. استاندارد

نیز از این سه استاندارد  NodeMcu گیگاهرتز می باشند بیشترین کاربرد را در سیستم های تجاری و منازل دارند. ماژول

را  TCP/IP آشنایی با اصول و مبانی انواع شبکه های مبتنی بر پشتیبانی می کند. برای درک بهتر موضوع توصیه می شود مقاله

 .مطالعه نمایید

 

https://electrovolt.ir/%d8%a2%d8%b4%d9%86%d8%a7%db%8c%db%8c-%d8%a8%d8%a7-%d8%a7%d8%b5%d9%88%d9%84-%d9%85%d8%a8%d8%a7%d9%86%db%8c-%d8%b4%d8%a8%da%a9%d9%87-%d9%87%d8%a7%db%8c-%da%a9%d8%a7%d9%85%d9%be%db%8c%d9%88%d8%aa%d8%b1/
https://electrovolt.ir/%d8%a2%d8%b4%d9%86%d8%a7%db%8c%db%8c-%d8%a8%d8%a7-%d8%a7%d8%b5%d9%88%d9%84-%d9%85%d8%a8%d8%a7%d9%86%db%8c-%d8%b4%d8%a8%da%a9%d9%87-%d9%87%d8%a7%db%8c-%da%a9%d8%a7%d9%85%d9%be%db%8c%d9%88%d8%aa%d8%b1/
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 ESP-XX معرفی ماژول های وای فای سری

می باشد که به علت کوچک بودن  Al-thinker نام یک سری از ماژول های وای فای ساخت شرکت چینی ESP-XX ماژول های

در پروژه های اینترنت  دلار ( به بسیاری از پروژه های میکروکنترلری با کاربردهای مختلف از جمله 4و کم هزینه بودن ) تقریبا 

می باشد که مدتی بعد  ESP-12 اشیاء راه پیدا کرده است. معروف ترین و پرکاربردترین این ماژول ها ، نسخه دوازدهم آن یعنی

نیز ساخته و روانه بازار شد. در شکل زیر انواع  ESP-12F و ESP-12E از ارائه آن ، نسخه های اصلاح شده این ماژول تحت عنوان

 .ساخته شده را مشاهده می کنید ESP-XX هایمدل 
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استفاده شده  Espressif System ساخت شرکت چینی ESP8266EX در ساخت همه این ماژول ها از یک چیپ یکسان به نام

مگاهرتز می باشد. روی این  081با توان مصرفی بسیار پایین و سرعت  RISC بیتی 24ت. این چیپ در واقع یک پردازنده اس

درصد توان آن را  41قرار دارد که در مجموع  WiFi با پشتیبانی کامل از پروتکل RTOS پردازنده از یک سیستم عامل بی درنگ

وان این چیپ میتواند برای برنامه نویسی توسط کاربر استفاده شود. در شکل زیر درصد دیگر ت 81اشغال می کند و در نتیجه 

 .را مشاهده می کنید ESP8266EX چیپ

 

روی آن  ESP8266EX هیچ پوششی وجود ندارد و چیپ ESP-XX همانطور که مشاهده می کنید در برخی از ماژول های

مشخص است به این ماژول ها بدون شیلد گفته می شود. شیلد فلزی رسانا است که از تاثیر گذاشتن نویز روی چیپ ها جلوگیری 

 ESP-12F و ESP-12  ،ESP-12E هتری از خود نشان می دهد. ماژول هایمی کند و در نتیجه ماژول پایدارتر شده و عملکرد ب

نسبت به دو ماژول  ESP-12F هر سه دارای شیلد هستند اما تفاوت های جزئی با هم دارند. یکی از این تفاوت ها بهبود آنتن

 .در فروشگاه الکترو ولت مراجعه نمایید  >>این لینک << دیگر است. برای خرید این ماژول ها به تنهایی میتوانید به

  

 

 چیست؟ NodeMcu برد توسعه

به  USB ولت و برای ارتباط با کامپیوتر نیاز به یک مبدل 2.2برای راه اندازی نیاز به تغذیه  ESP-XX تمامی ماژول های وای فای

همه قطعات و وسایل مورد نیاز برای راه اندازی ماژول وای فای تعبیه شده است. اما  NodeMcu سریال دارند. در برد توسعه

https://electrovolt.ir/product-tag/esp8266/
https://electrovolt.ir/product-tag/esp8266/
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خاص طراحی شده در واقع نوعی  firmware به علت NodeMCU به اینجا ختم نمی شود. برد توسعه NodeMcu لزوم تولید

ه اینترنت اشیا به شمار می رود که می توان آن را با انواع اسکریپت های برنامه نویسی در زمین (Embedded) از بوردهای امبدد

 درون چیپ ( Arduino Boatloader ) به کار گرفت. همچنین قرار گرفتن بوت لودر آردوینو  Lua  ،MicroPython نظیر

ESP8266EX باعث شده است تا برد توسعه NodeMcu را بتوان نوعی شیلد آردوینو ( Arduino Sheild )  تلقی کرده که با

 .) نرم افزار برنامه نویسی انواع بوردهای آردوینو ( قابل برنامه ریزی است Arduino IDE نرم افزار

 : در سه نسخه زیر تولید شده است NodeMcu برد توسعه

  که در آن از ماژول 1.0( یا ورژن  4102نسخه اول ) سال ESP-12 استفاده شده است. 

  که در آن از ماژول 0نسخه دوم یا ورژن ESP-12E استفاده شده است. 

  که در آن از ماژول 0نسخه سوم یا همان ورژن ESP-12F استفاده شده است. 

و پایه های بیرون آمده از برد توسعه می باشد  ESP در کل تفاوت های کمی بین این سه نسخه وجود دارد که شامل نوع ماژول

را مشاهده  0و  1.0این ماژول وجود دارد و نسخه های قبلی کمتر یافت می شود. در شکل زیر هر دو نسخه  2اما اکنون نسخه 

 .می کنید

 

 و LoLin سورس بوده ، شرکت های مختلفی اقدام به ساخت آن نموده اند که مهمترین آن ها از آن جایی که این برد اوپن 

Amica  می باشند که هر دو آن ها NodeMcu  می باشند اما تفاوت های جزئی با هم دارند. یکی از این تفاوت ها ابعاد آن می

بردهای با ابعاد کوچک مناسب تر است. می باشد و برای کار NodeMcu LoLin کوچکتر از NodeMcu Amica باشد که

 به سریال آن است که در برند USB تفاوت دیگری که در بردهای شرکت های مختلف دیده می شود ، نوع آی سی مبدل
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Amica از آی سی CP2102 و در برد LoLin از آی سی CH340 استفاده شده است. به علت اینکه آی سی CH340  آی سی

 ارزان تر از دیگر برند می باشد. در شکل زیر هر دو برد توسعه LoLin با برند NodeMcu ردهای توسعهارزان تری می باشد ، ب

NodeMcu را با برندهای LoLin و Amica  از زاویه جلو و پشت مشاهده می کنید. هر دو این ماژول ها برای کار مناسب بوده و

بیشتر آشنا  LoLin نسبت به دیگری ندارد. در ادامه با برد توسعه هیچ کدام به جز تفاوت های گفته شده مزیت یا برتری خاصی

 .خواهید شد

 

 

  

 از فروشگاه الکترو ولت  NodeMCU LoLin V3لینک خرید برد توسعه

https://electrovolt.ir/product/%d8%b4%db%8c%d9%84%d8%af-%d9%88%d8%a7%db%8c-%d9%81%d8%a7%db%8c-nodemcu-esp8266/
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 NodeMcu LoLin V3 پایه های بورد توسعه

 

  

به  General Purpose Input/Output مخفف ) GPIO پایه های D8 تا D0انطور که در شکل فوق مشاهده می کنید ، هم

می باشد و در هنگام برنامه  NodeMcu هستند. اما این اعداد فقط نامگذاری بورد توسعه ( معنی ورودی/خروجی همه منظوره

برای برنامه  ( D0 برای GPIO16 مثلا ) اعدادی که جلوی آن نوشته استنویسی این اعداد مورد استفاده قرار نمی گیرد بلکه 

می باشند که در شکل زیر این اعداد را مشاهده  ESP8266 نویسی مورد استفاده قرار می گیرد. این اعداد همان پایه های ماژول

 .می کنید
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هستند که برای ارتباط با کامپیوتر یا میکروکنترلر از آن استفاده می شود. هر چند که  TX و RX به ترتیب D10 و D9 پایه های 

 TX و RX کافی است و این پایه ها برای D8 تا (D پایه 0نیز باشد اما در اکثر پروژه ها استفاده از  GPIO این پایه ها میتواند

 .استفاده می شود

متصل شده است که در هنگام پروگرام کردن روشن و  NodeMcu آبی رنگ روی برد توسعه LED به یک D4 نکته : پایه

 .خاموش می شود. بنابراین بهتر است زمان پروگرام کردن به این پایه وسیله ای متصل نباشد

 

 

 NodeMcu LoLin V3 روش های تغذیه بورد توسعه

 .پایه های مربوط به تغذیه بورد را در شکل زیر مشاهده می کنید
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 : غذیه این بورد روش های راحتی وجود دارد که عبارت است ازبرای ت

ای روش برای زمانی که بورد را پروگرام می کنید به کار می رود  : Micro USB اتصال به کامپیوتر و گرفتن تغذیه از پورت -1

 .اما در هنگام استفاده درون مدار نمیتواند استفاده شود
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استفاده می  ESP8266 ولت خارجی برای تغذیه ماژول 2.2ولت : در این روش از یک رگولاتور  2.2اتصال ولتاژ رگوله شده  -2 

 .شود

 

  

 .ولت : در این روش از آداپتور یا باتری های کتابی برای تغذیه بورد میتوان استفاده کرد 41تا  5اتصال ولتاژهای  -3
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ولت ورودی را تحمل کند و  41قرار داده شده است میتواند حداکثر تا  NodeMcu که روی برد توسعه تذکر : رگولاتوری

میلی آمپر میتواند فراهم کند. بنابراین در  811ولت تنظیم شده تحویل دهد اما این رگولاتور حداکثر جریانی معادل  2.2خروجی 

 .ی دیگر باید به این موضوع توجه شودروی بورد برای تغذیه مدارها 2Vهنگام استفاده از پایه 

  

 

 با نرم افزار آردوینو NodeMcu راه اندازی بورد توسعه

چشمک زن می باشد را بر روی آن پیاده سازی  LED می رویم و اولین مثال که NodeMcu در این بخش به سراغ راه اندازی

 نیاز به یک بردبورد ، سیم بردبوردی ، یک عدد NodeMcu ه برای پیاده سازی علاوه بر برد توسعهخواهیم کرد. توجه نمایید ک

LED و یک کابلMicro USB  برای اتصال به کامپیوتر نیز می باشد. توجه نمایید که قبل از اتصالNodeMcu   به کامپیوتر

 .را نصب نمایید. شکل زیر نحوه اتصال مورد نیاز برای این مثال را نشان می دهد CH340 درایور باید

 

  

 Arduino IDE ود و نصبگام اول : دانل

  IDEنسخه ) دانلود و سپس نصب نمایید این لینک  را از طریق  Arduino IDEابتدا باید نرم افزار  NodeMcuبرای راه اندازی

 ( می باشد 0.6.8سیستم تست شده در هنگام نوشتن این آموزش 

 

https://electrovolt.ir/wp-content/uploads/2017/07/CH341SER_ElectroVolt.ir_.zip
https://electrovolt.ir/wp-content/uploads/2017/07/CH341SER_ElectroVolt.ir_.zip
https://www.arduino.cc/download_handler.php?f=/arduino-1.6.9-windows.zip
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 در آردوینو NodeMcu گام دوم : نصب بورد توسعه

وجود ندارد. برای آن که بتوانید بر  NodeMcu فزار آردوینو در حالت پیش فرض هیچ بورد ، کتابخانه یا مثالی برایدرون نرم ا

را بر روی نرم افزار آردوینو نصب کنید. برای این  NodeMcu آردوینو برنامه نویسی کنید باید ابتدا IDE روی این ماژول توسط

 .شوید Preferences وارد File وید و از قسمتمنظور ابتدا وارد نرم افزار آردوینو ش

 

 

 .را بزنید OK کپی کنید و Additional Boards Manager URLs سپس لینک زیر را در قسمت

http://arduino.esp8266.com/stable/package_esp8266com_index.json 

 .شکل زیر این موضوع را نشان می دهد
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 .نید تا پنجره مربوطه باز شودکلیک ک Boards Manager را انتخاب کرده و روی Board گزینه Tools سپس از منوی
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را تایپ کرده و آخرین نسخه را نصب نمایید. نرم افزار شروع  esp8266 عبارت Boards Manager در بخش جستجو پنجره

 .کند که ممکن است مدتی طول بکشدهای مربوطه میبه دانلود و نصب پکیج
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مراجعه کنید. مشاهده می کنید که  Tools -> Board را ببندید و به مسیر Boards Manager بعد از اتمام نصب ، پنجره

گزینه دوم یعنی  LoLin توسعه قابل انتخاب می باشد. برای برد NodeMcu از جمله ESP8266 انواع بوردهای مبتنی بر ماژول

0.1 NodeMcu باید انتخاب شود. 
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 گام سوم : انجام تنظیمات

در دسترس می باشد. معمولا این تنظیمات در حالت  Tools تنظیماتی وجود دارد که از منوی NodeMcu برای اتصال به بورد

 پیش فرض صحیح می باشد و نیاز به تغییر خاصی ندارد. شکل زیر این تنظیمات را نشان می دهد. تنها تغییری که برای

NodeMcu LoLin V3  مورد نیاز است ، تنظیمات Baud Rate نرخ سرعت ارتباط ( می باشد که در گزینه ( Upload 

Speed   می باشد که باید در عمل تست شود.  0611یا  005411میتوان آن را تغییر داد. سرعت آپلود یکی از دو گزینه

به کامپیوتر شناسایی شده را وارد کنید. اگر هیچ  NodeMcu ، پورتی که با اتصال Port همچنین باید دقت نمایید که در گزینه

 ( COM8 در اینجا ) وصل نباشد در این گزینه تنها یک پورت نشان داده می شود کامپیوترتان USB وسیله جانبی به پورت های

 .که باید آن را انتخاب نمایید

 

  

 گام چهارم : نوشتن و پروگرام کردن برنامه

می رسد. بدین منظور ساده ترین مثال را پروگرام می کنیم اما توجه نمایید که کلیه  NodeMcu به اجرای اولین مثال با نوبت

وجود دارند که در شکل زیر مشاهده می  File -> Examples در مسیر NodeMcu مثال های از پیش نوشته شده برای بورد

 .کنید
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 Sketch چشمک زن کافی است تا کد زیر را کپی کرده و در یک LED بعد از انجام کلیه مراحل قبل ، برای راه اندازی مثال 

 .قرار دهید ( File -> New جدید ) گزینه

int LedPin = 5; 

void setup() {  

 pinMode(LedPin, OUTPUT); 

} 

void loop() { 

 digitalWrite(LedPin, HIGH); // turn the LED on (HIGH is the voltage level) 

 delay(1000); // wait for a second 

 digitalWrite(LedPin, LOW); // turn the LED off by making the voltage LOW 

 delay(1000); // wait for a second  

} 
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 : توضیح برنامه

 pinMode توسط تابع Setup ابتدا در حلقه ( ESP ماژول 5پایه  ) بورد توسعه D1 متصل شده به پایه LED در این برنامه

 .یک ثانیه روشن و ثانیه دوم خاموش می شود digitalWrite توسط تابع loop خروجی می شود و سپس در حلقه

  

را بزنید. اگر آپلود با خطایی مواجه  Upload تذکر : برای پروگرام کردن برنامه کافی است تا در نوار ابزار نرم افزار آردوینو گزینه

 Upload Speed احتمال زیاد با تغییر ) شد مشکل از تنظیمات بورد توسعه می باشد که در مرحله قبلی توضیح داده شد

 .ماژول نمی باشد firmware که در این مرحله هیچ نیازی به تغییر دقت نمایید ( مشکل حل می شود

  

 

 .در بخش های بعدی آموزش های جذاب تری از این برد خواهیم گذاشت

 

 .بپرسیددر سایت همین مطلب مربوط به ش نظرات را در بخ NodeMcu هر گونه سوال یا مشکل در خصوص راه اندازی برد

 

 .بخش های بعدی آموزش به زودی قرار خواهند گرفت و به محض قرار گرفتن در کانال تلگرام الکترو ولت اطلاع رسانی می شود

 

 


